
Understanding Geometric Pattern and its Geometry 
(part 3) – Using Technology to Imitate Medieval 

Craftsmen Designing Techniques 

Mirosław Majewski 

mirek.majewski@gmail.com  

New York Institute of Technology, School of Arts & Sciences, 

Abu Dhabi campus, UAE 

Abstract: The medieval artists produced incredibly complex geometric art using very basic tools – a ruler, 
simple compasses, and several templates drawn on a parchment or paper. This was all that they had and 
all that they needed. They did not have computers, AutoCAD, or printers. With all the modern tools, we still 
have problems reconstructing the old geometric art correctly, and our easy-to-use tools do not help much.  
In this paper, we will explore one of the possible ways of creating geometric patterns using simple 
geometry software and following the old XV century methods.  

Introduction 

This paper is a continuation of my two articles published in eJMT (see [2] and [3]). Thus I will follow the 
concepts described in these papers without significant repetitions. However, to understand the topic of 
this paper, at least some basic notions have to be mentioned.  

Geometric patterns are part of human culture since the earliest times of our civilization. They started as 
simple decorations of tools used by humans; they evolved over time, and century after century, they 
became more and more complex. The same is with the geometry used in the creation of these patterns. 
We may assume that the geometry of the first geometric patterns was more intuitive than formal. 
However, as our knowledge of geometry became more sophisticated, we see also more sophisticated 
geometric patterns. This process can be observed by analyzing illustrations in any illustrated book 
devoted to the history of ornament. An excellent example of such a book is ‘The Grammar of Ornament’ 
by Owen Jones. By looking at illustrations in this book, we can see the increasing amount of geometry in 
designs of ancient Greeks, Byzantine and Roman artists, medieval artists in Europe, and artists in some 
Muslim countries. The geometric sophistication of medieval arts is a culmination of this process. At the 
same time, we see in Europe the Gothic tracery – more and more complex designs, and star and 
geometric rosette patterns, so-called gereh, in Muslim countries. These developments grow on parallel 
tracks and use only partly different geometric concepts. In Gothic tracery, we have a ‘game’ of tangent 
circles and curves, while in gereh patterns, we have art using segments organized in complex networks 
of stars and symmetric polygons. If we ignore these differences, then we will notice that artists from 
both regions used the same or similar geometric concepts of symmetry and structural design.  

The two photos (fig.1 and fig.2) show geometric designs from Europe and the Middle East. It is worth 
mentioning here that in our times, the Gothic tracery is no longer developed while gereh patterns are 
still used, and new patterns are still created. The design on fig. 2 was completed in recent years, and we 
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see there relatively modern approach – symmetries of particular shapes, with the whole structure 
asymmetric.  

  

Fig. 1 (left) – an example of a Gothic tracery – a fragment of the portal in the church Saint-Pierre, in 
Caen, France.  
Fig. 2 (right) – an example of a gereh – a fragment of wooden doors from the Çamlıca Mosque in 
Istanbul, Turkey.  

Tools of medieval masters 

While looking at geometric designs from the medieval and later times, we often forget to imagine what 
tools were used to create these designs. We blindly think about our computers, CAD or Rhino software, 
and other computing tools that can calculate for our size and angles of every element of a geometric 
design. Thus, let us get back to the past.  

We know for sure that a medieval designer had in his toolbox a ruler or a few of them. In one of the 
Persian medieval texts, the unknown author describes how to make drawing triangles. Thus we may 
assume that medieval masters used drawing triangles – this what we call a ‘set square’ nowadays.  

We know for sure that medieval masters used compasses. But we cannot expect that their compasses 
were similar to these we can buy in our shops. How often we read about constructions with rusty 
compasses without realizing what this is? This is a set of compasses with a fixed distance between pins. 
In practice, this means a wooden stick with two nails. At least one was made out of the lead. This was the 
drawing part. Did they use rusty compasses in their works?   

Then we know for sure that medieval masters used parchment or later paper to keep templates of designs 
or parts of them. The famous Topkapi scroll is a collection of such templates. There exist a few other 
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such scrolls, and each of them is a collection of templates of architectural decorations or plans of 
buildings.  

Let us look at how we can model all these tools in our times using geometry software. We want its 
functionality to be as close as possible to the means of medieval designers and techniques used by them. 
We have a few computer programs for school geometry that mimic techniques and tools used in 
geometric constructions from the past. For the sake of this paper, we will use Geometer’s Sketchpad, but 
one can use GeoGebra or any other geometry software.  

Essential tools in Geometer’s Sketchpad(i) 

As I said already in parts 1 and 2 of this paper (see [2] and [3]), Sketchpad is the tool I have been using for 
constructing all the ornaments in all my articles and books related to geometric pattern design. Perhaps 
some of my readers would like to try this approach and use Sketchpad to explore geometric ornaments. 
Therefore in this text, we will look into Sketchpad as a construction tool for geometric ornaments and 
discuss a few things that are useful in this work. However, this text is not intended to be a Sketchpad 
tutorial. There are several Sketchpad tutorials available on its web site and a comprehensive help system 
inside the program. One can quickly learn how to use the program entirely on his or her own. In this 
paper, we will discuss only a few issues specific to the creation of geometric ornaments.  

Fig. 3 Toolbox in The Geometer’s Sketchpad. 
• Several tools are available in Sketchpad. Here are all of them listed 

from top to bottom.  
• Selection tools: select and move, rotate, scale object (or the whole 

construction) 
• Construct a point 
• Draw a circle using two points – the center of the circle and a 

point on its edge 
• Draw a segment, ray, or line 
• Draw a polygon 
• Label objects or write text 
• Marker tool,  
• Info tool, and a Tool to create custom tools     

Sketchpad is a straightforward computer program to work with plane geometry. We can draw there 
points, lines, segments, arcs, circles, and other objects used in elementary geometry (see fig. 3). This is 
what medieval masters were able to draw with their tools. Moreover, in the Sketchpad menu ‘Transform,’ 
we have four operations ‘Translate,’ ‘Rotate,’ ‘Dilate,’ and ‘Reflect.’ Each of them is a computer version of 
manual operations – duplicate fragment or whole design on a paper and copy it in another place of the 
design. The copy can be rotated or reflected (take paper upside down).  

The number of creation tools in Sketchpad is somewhat limited but still enough to proceed with even 
the most complex geometric constructions. If a tool is missing, we can always create it and then use it in 
our works. Therefore, later we will take a closer look at the process of the creation of custom tools in 
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Sketchpad. The customs tools in Sketchpad should be considered as templates of geometric 
constructions that we can use to insert or apply in any place of our design.  

Multiple pages 

A very specific feature of Geometric Sketchpad are notebooks with multiple pages. This is what we often 
do while designing a complex pattern – draw a part of a construction, copy it on a separate paper and 
add to it some elements, then copy it again and add something else. If one of the steps is wrong, we can 
always go back to the previous drawing and start again. Multiple pages in GSP notebooks allow us to go 
back and start over from a point that we consider as a starting point for further development.  

The next three figures show a sample GSP notebook with three pages. Each of them shows a different 
stage of the construction process. A more complex design can be elaborated on more pages. In the same 
GSP notebook, we may have designs of a few geometric constructions.  

 

Fig. 4a Three stages of a sample 
designing process (page 1) 
 
In the first figure, we have a photo of a 
metal panel with a hand drawing of a 
possible tessellation. Each tessellation 
tile is a container for a local symmetry 
in the pattern.  
On the same figure, we have a drawing 
(right side) showing relations between 
tessellation tiles and patterns on them.  
 

 

Fig. 4b Three stages of a sample 
designing process (page 2) 
 
The second figure shows two 
tessellation tiles that can be used to 
recreate the whole pattern. Note – the 
design in the hexagon is more 
complicated than on the metal panel.  
 
These two tiles are the custom tools 
that we need for this design. About 
custom tools, we will talk in the next 
section of this paper.  
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Fig. 4b Three stages of a sample 
designing process (page 3) 
 
Here we show the last page of the 
notebook with a sample pattern using 
these two tessellation tiles.  

User-made custom tools 

In Geometer’s Sketchpad, the primary key to complex patterns design are custom tools. In the following 
example, we walk through the creation of a simple custom tool to create a regular pentagon starting 
from a segment that will be the side of the pentagon. First, we will construct such pentagon, and then 
we will use our construction to create a simple pattern using pentagons. Finally, we will show how this 
tool can be used in current or future works.  

Fig. 5abc Construction of a regular pentagon from a 
given side. 

STEP 1: Start by drawing a segment AB. Here A and 
B are the ending points of the segment, and these 
two points will be important later while creating 
the pentagon tool.  
Construct a bisector of the segment AB. This can be 
done by drawing two circles with centers in A and 
B, respectively, and radius AB. By connecting points 
of intersection of these two circles (points C and D), 
we create a line that is our bisector. 
Construct three more lines: line extending segment 
AB, and two lines perpendicular to AB in points A 
and B.  
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STEP 2: To find other vertices of the pentagon, we 
will need three more circles (the thick lines in the 
figure to the right). 
Draw a circle with a center in G and its radius 
equal to GE.  You should obtain two new points on 
line AB: I and J.  
Use the new points I and J to draw two more 
circles, one with the center in J and another one 
with the center in I and radii AI and BJ, 
respectively.  
This time we obtained three additional points K, L, 
and M. These points are the remaining vertices of 
the pentagon. By connecting them with segments, 
we get the outline of the pentagon.  

 

STEP 3: Creation of the tool 
This is the final step in creating a tool to produce a 
pentagon from a given segment.  
Select the points A, B, K, M, and L, as well as all 
segments connecting these points. No other points, 
lines, or segments should be selected. With this 
selection on the screen, open the tool to create 
customs tools (see fig. 2) and choose ‘Create New 
Tool,’ write there your preferred name for it, and a 
new custom tool will be created. Now the new tool 
can be used as many times as you need it.   

   

COMMENT: Before creating a new tool, it is worthwhile to hide or remove labels of objects used in the 
tool. Otherwise, every time while creating multiple instances of the pentagon, we will get several 
unnecessary labels. Custom colors and point or line styles used while creating the tool will also be 
preserved. This means that if we made the pentagon tool using green, medium-size line, and yellow 
points, then each new pentagon created with this tool will have the same colors and styles.  

Important – the construction of the pentagon described here, although it is a slightly more complex than 
many other constructions of regular polygons, it is accurate. We can check in Sketchpad that all angles 
have the same value, 108°, and the full measure of all angles is 540°.  
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If we do not want to follow classic constructions of regular polygons, then we can always use the 
opportunities hidden in GSP. For example, a regular pentagon can be treated as a set of five triangles, 
each one with angles: 54, 54, and 72 degrees. Thus it is enough to create one such triangle, and then by 
using four consecutive reflections about sides of the triangle, we can obtain the whole regular pentagon. 

Fig. 6 A simple construction created 
with our pentagon tool  

In this construction, the floral 
ornament and colors are similar to 
those that I have seen in one of the 
mosques in Istanbul.  
RGB values of colors used here are 
as follows: 
 
Dark dusty blue: RGB 87, 72, 104 
Dusty red: RGB 241, 96, 67 
Yellow: RGB 255, 170, 87 
Light salmon (background): RGB 
255, 224, 197  

 

While creating a custom tool, it is essential to decide what the starting object for the construction should 
be. For example, while creating a regular pentagon, we used one of its future edges with two ending 
points. In fact, as we can quickly notice, the edge was not very important. The whole construction could 
be done, starting from two points only. One can also think about creating a pentagon inscribed in a circle, 
where the center of the circle and one point on its edge can be the starting objects for the pentagon tool. 
There are also known constructions of a pentagon inscribed in an existing hexagon, square, or another 
polygon. Each time the starting objects can be different. In this paper, we use only polygons created from 
a given edge, i.e., a segment and the two, ending it points.  

Suppose we have created our custom tool or tools. Now we have to think about how we can use them in 
some of our later works. A good solution is to put all of them in a selected folder and ask Sketchpad to 
load custom tools on start. We have already noticed that in Sketchpad, at the very bottom of the custom 
tool menu, we have an option ‘Choose Tool Folder.’ If we point out where the folder for the tools is and 
save our files with custom tools in this folder, we will be able to use any of these tools in our further 
works. In my works, I usually declare, as a tool folder, the folder where I save all my Sketchpad files. This 
way, I have access to all tools that I have created in the past. This is very convenient – usually, I use a 
large number of custom tools in my constructions.  
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A real working example 

 

 
Fig. 7 Mihrab from the 
Akşehir Mosque in Turkey 
 
In the photo, we can 
distinguish a few different 
patterns. Each of them can 
be created by a direct 
construction or by using 
custom tools. We will take 
one of these patterns, and 
we make an analysis of it, 
and then we will create 
custom tools for it.  
For the purpose of this 
paper, we will take the 
pattern from the border. It 
is simple enough to do it in 
about 20 minutes, and it 
involves a few interesting 
ideas from elementary 
geometry. Below I show a 
small fragment of it. Note, 
the thick long horizontal 
lines are the borders of the 
pattern. Thus we examine 
the part that is enclosed 
between these two lines. 

 

 

Working process for the pattern from Akşehir Mosque 

 

Fig. 8 Hypothetical tessellation for the pattern 
from Akşehir Mosque 
Although this design can be done in a few 
different ways, we will choose the typical gereh 
design process – create the contour, construct 
tessellation for the pattern and then draw 
decoration for each tessellation tile. Here we 
show one of a few possible tessellations for this 
pattern.  
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Fig. 9 Tiles used in the tessellation 
One can easily notice that in the drawing (fig. 8), we 
have only two different tiles – a square and a 
semiregular hexagon with all edges equal and two 
angles 1350 and 900. Thus this hexagon is one of many 
shields used in geometric pattern design.  
Creation both tools – a square and a hexagonal shield is 
a simple task.  

 

Fig. 10 Geometry of the tessellation from fig. 8 
By assembling the tessellation of the pattern using tools 
for square and hexagon, we see that the points on each 
edge form the sequence: a,a,a,b. Where ‘a’ is half of the 
diagonal of the square, and ‘b’ is the length of the side of 
the square (b=a√2). We can see it on the bottom edge AB. 
Here AC= CD=DE and EB is the side of the small square.  
To construct this tessellation, we need to find a way to 
divide the segment into the sequence a,a,a,b, where, as 
we said, ‘b’ is the side of the square and ‘a’ is half of its 
diagonal.  
We will create a tool that will allow us to divide a 
segment of any length into a,a,a,b sequence.  

 

Fig. 11 Construction of the division a,a,a,b 
First, we draw a segment AB, create its midpoint, and 
then draw three small circles with the same radius. The 
last, larger circle has the radius equal to the diagonal of 
the shown here square.  

 

 

Fig. 12 Construction of the division a,a,a,b (cont.) 
We draw a segment through points B and C. Then, we 
draw three lines parallel to this segment. On the 
segment AB, we mark three points of intersection of AB 
with parallel lines.  
Now – select points A and B and the three points 
between them and create a new tool (say ‘aaab’ tool).  
 

mDAB = 90.00000°

mABC = 135.00000°
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Fig. 13 Above, we show how the tool was used to create the tessellation. Arrows indicate the direction 
of points from A to B. 

 

Fig. 14 Construction of tools for the design of the 
pattern on tiles of the tessellation 
The creation of these two tools is straightforward. 
The dotted lines (for square tile) and dashed lines 
for semiregular hexagon are the grids for elements 
of both patterns. The red points in both cases are 
the starting points for each tool.  

 

Fig. 15 Complete tools for this design 
The two figures shown here are often used shapes 
and patterns in many other designs with octagonal 
local symmetries. We can see them often in 
geometric patterns from Central Asia and other 
regions.  
Fig. 16,17 (below) Design of the template for pattern 
from Akşehir Mosque.  
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Fig. 18 Large pattern created using template from fig. 17 and reflections of it about edges of the template. 
Note, the original pattern contains interlaces. This means we need a template that is four times larger 
than the template developed here (2x2), and to produce a similar design, we should use translations of 
the template only.  

A few hints on using Sketchpad in creating geometric ornaments 

Edges of fills: While constructing geometric ornaments, we frequently use filled polygons or circles.  If a 
polygon touches the boundary of a template, we should use framed polygons, i.e., polygons with an edge. 
Otherwise, after replicating the template, we will find narrow gaps between some polygons. This is a 
mostly unwanted effect if we use dark colors for fills.   

Transparency: Using polygons with edges brings another problem. Sketchpad, by default, uses 50% 
transparency for the fills. This way, overlapping and filled polygons, or circles, show the area covered by 
two or more objects in a different color. If the polygon has an edge, then the edge is not transparent, and 
in such a case, its color is darker than the color of the fill. Therefore in some situations, it is convenient 
to use filled polygons or circles with no transparency. This way, we can be sure that the filling will have 
the same color as its edge. Note that transparent colors can get out of hand if we copy and paste our 
constructions in some graphics programs. Some popular graphics programs may introduce unexpected 
changes of colors to our transparent fills. Note also that graphics programs usually have a more 
sophisticated coloring tool than Sketchpad. Therefore, if we wish to get more interesting color effects, 
it can be convenient to create the ornament in Sketchpad, copy it into a graphics program, and apply a 
specific color scheme.  The ornament shown in figure 6 was completed in Sketchpad with completely 
random fills, copied from the Sketchpad notebook, and pasted into Adobe Illustrator. Then the Illustrator 
coloring palette was used to color all fillings.   

Saving graphics: In Sketchpad (Windows version), we can save our constructions as an EMF file (Microsoft 
Windows Enhanced Metafile). This is a vector file format. This simply means that all constructed 
elements will be saved using their coordinates, parameters, and equations. Therefore, the file size 
depends only on the number of elements in our construction. The dimensions of the construction on the 
Sketchpad screen are not really important for the file size. However, they are vital if we want to use it in 
a publication. Scaling of lines and points will affect the thickness of lines and the size of points.  
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Buttons to hide elements: While creating a complex ornament, we use multiple grids. If we are not sure 
how to proceed with the construction, it can be useful to select each grid separately and create a button 
to hide and show the grid (Sketchpad menu: Edit > Action Button > Hide/Show). 

Do not create unnecessary elements:  While performing multiple transformations, we often develop many 
unnecessary details by doing multiple reflections or rotations of an ornament with construction points 
(ends of segments, or vertices of polygons).  Then we can face two problems. One of them is hiding at 
the end of our work all these unnecessary points, sometimes edges, etc. If we only have a small amount 
of them, then we need a few minutes to hide them all. However, if we have hundreds of such unnecessary 
elements, we may never finish the cleaning process. There is one more issue to consider. Sketchpad, like 
any other vector graphics program, must recalculate locations of all elements if we move them on the 
screen or scale. Thus with too many elements created in our notebook, Sketchpad will work much slower. 

Use multiple copies of your construction: I frequently have this situation that, at some stage of my work, 
I wish to try a few different options; for example, use different colors or different width of lines and 
compare both resulting images. In such a case, in a critical moment when two or more options are going 
to be tested, I create a copy of my work and apply changes to the copy. At the same time, the original 
construction is safe, and later I can always return to it. Multiple copies of our work can be created as 
separate files or in one file as multiple tabs (Sketchpad menu: File>Document Options>Add 
Page>Duplicate).  
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